
Patient Tracking Spreadsheet Template (Version 1) 
Instructions for Care Managers 

Effective management of common mental health conditions requires the ability to track clinical 

outcomes for populations of patients and to support systematic changes in treatment for patients who 

are not improving as expected. This approach is one of the core principles of Collaborative Care and is 

essential in ensuring that goals are being met. These instructions will help your organization use the 

AIMS Center Patient Tracking Spreadsheet Template. 

Please send all questions, feedback, and suggestions for improvement on the Patient Tracking 

Spreadsheet Template to aims_spreadsheet_registry@uw.edu.  

PLEASE NOTE: These instructions are based on Excel® 2010. They may not work with other versions of 

Excel®. Neither the Patient Tracking Spreadsheet nor these instructions are intended for use with 

Numbers®. 

Table of Contents 
Disclaimer ............................................................................................................................................ 4 

Information Regarding HIPAA Compliance ........................................................................................... 4 

Spreadsheet Data Manager .................................................................................................................. 4 

Section I – Using the Spreadsheet ........................................................................................................ 5 

Getting started in Excel® ........................................................................................................................... 5 

Spreadsheet Orientation and Data Entry .................................................................................................. 6 

Fixed top rows ....................................................................................................................................... 7 

Saving the document and using auto-backup ....................................................................................... 7 

Printing the Patient Tracking worksheet .............................................................................................. 7 

Printing the Caseload Overview worksheet .......................................................................................... 8 

Transferring a patient to another care manager’s spreadsheet ........................................................... 8 

Section II – Patient Tracking Worksheet: Overview of Functionality ..................................................... 9 

Column A: MRN ......................................................................................................................................... 9 

Column B: Name ....................................................................................................................................... 9 

Column C: Treatment Status ..................................................................................................................... 9 

Column D: Display ................................................................................................................................... 10 

Column E: Tickler .................................................................................................................................... 10 

https://aims.uw.edu/resource-library/patient-tracking-spreadsheet-template
mailto:aims_spreadsheet_registry@uw.edu


 

2 
 

Column F: Episode Number .................................................................................................................... 11 

Creating a new episode of care .......................................................................................................... 11 

Column G: Follow-up Contact Number ................................................................................................... 12 

Column H: Date Follow-up Due .............................................................................................................. 12 

Column J: Actual Contact Dates .............................................................................................................. 13 

Column K: Type of Contact ..................................................................................................................... 13 

Column L: PHQ-9 Score ........................................................................................................................... 13 

Disclaimer regarding target scores ..................................................................................................... 13 

Note regarding a deferred initial PHQ-9 score ................................................................................... 13 

Column M: Percent Change in PHQ-9 Score ........................................................................................... 14 

Disclaimer regarding target scores ..................................................................................................... 14 

Column N: GAD-7 Score .......................................................................................................................... 14 

Disclaimer regarding target scores ..................................................................................................... 14 

Note regarding a deferred initial GAD-7 score ................................................................................... 14 

Column O: Percent Change in GAD-7 Score ............................................................................................ 15 

Disclaimer regarding target scores ..................................................................................................... 15 

Column P-Q: Care Manager Contact Notes and Flag for Psychiatric Case Review ................................. 15 

Column R: Date of Psychiatric Case Review ............................................................................................ 15 

Section III – Caseload Overview Worksheet: Overview of Functionality .............................................. 16 

Red Text at the Top of the Caseload Overview Worksheet .................................................................... 16 

De-Identify the Caseload Overview for Sending ..................................................................................... 16 

Column A: View Record .......................................................................................................................... 17 

Column B: Treatment Status ................................................................................................................... 17 

Column C: Name ..................................................................................................................................... 17 

Column E: Date of Initial Assessment ..................................................................................................... 17 

Column F: Date of Most Recent Contact ................................................................................................ 17 

Column G: Date Next Follow-up Due ...................................................................................................... 18 

Column H: Number of Follow-up Contacts ............................................................................................. 18 

Column I: Weeks in Treatment ............................................................................................................... 18 

Column J: Initial PHQ-9 Score ................................................................................................................. 18 

Column K: Last Available PHQ-9 Score .................................................................................................... 18 

Disclaimer regarding target scores ..................................................................................................... 18 

Column L: Percent Change in PHQ-9 Score ............................................................................................. 18 



 

3 
 

Disclaimer regarding target scores ..................................................................................................... 18 

Column M: Date of Last PHQ-9 Score ..................................................................................................... 19 

Column N: Initial GAD-7 Score ................................................................................................................ 19 

Column O: Last Available GAD-7 Score ................................................................................................... 19 

Disclaimer regarding target scores ..................................................................................................... 19 

Column P: Percent Change in GAD-7 Score ............................................................................................ 19 

Disclaimer regarding target scores ..................................................................................................... 19 

Column Q: Date of Last GAD-7 Score ...................................................................................................... 19 

Column R: Flag ........................................................................................................................................ 20 

Column S: Date of Most Recent Psychiatric Case Review ....................................................................... 20 

 

  



 

4 
 

Disclaimer 
THIS TEMPLATE ("TEMPLATE") IS PROVIDED "AS-IS” AND UW MAKES NO WARRANTIES, EXPRESS OR 

IMPLIED, INCLUDING WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, 

NONINFRINGEMENT AND INTERFERENCE IN USE OF THE TEMPLATE AND HEREBY DISCLAIMS ALL SUCH 

WARRANTIES AS TO ANY MATTER WHATSOEVER.  UW SHALL NOT BE LIABLE FOR ANY DIRECT, 

CONSEQUENTIAL, LOST PROFITS, OR OTHER DAMAGES SUFFERED BY THE USE OF THE TEMPLATE. IN NO 

EVENT SHALL UW BE RESPONSIBLE OR LIABLE FOR ANY CLAIM FOR PUNITIVE OR EXEMPLARY DAMAGES 

OR LOST PROFITS OR ANY OTHER FORM OF CONSEQUENTIAL DAMAGES ARISING FROM ANY USE OF THE 

TEMPLATE. USERS OF THE TEMPLATE HEREBY RELEASE UW, UWSOM, THEIR OFFICERS, AGENTS, 

EMPLOYEES, REPRESENTATIVES, FACULTY, AND STUDENTS FROM ALL CLAIMS RELATING TO THE 

FOREGOING. 

 

Information Regarding HIPAA Compliance 
It is the responsibility of the organization to establish a system for storing and sharing information 

contained in the AIMS Center Patient Tracking Spreadsheet Template in a way that complies with HIPAA 

regulations. It is strongly encouraged that the organization consult with whomever manages HIPAA 

compliance at the organization to ensure a secure plan is put into place.   

In many cases, it is acceptable to store the spreadsheet on a network drive—never a local hard drive—

with password protection. The password protection feature can be accessed by selecting File > Save As > 

Tools > General Options. The password can then be shared between the care manager, psychiatric 

consultant, and other personnel directly involved in care, if applicable.  

 

Spreadsheet Data Manager 
Due to the complex nature of the formulas and coding in the AIMS Center Patient Tracking Spreadsheet 

Template, each organization will need to designate a Spreadsheet Data Manager to make any changes 

to the structure of the spreadsheet. This includes adding rows to the Patient Tracking worksheet for 

additional contacts, adding columns for additional measurements, etc. The Spreadsheet Data Manager 

will need to have at the very least an understanding of Excel® formulas but should ideally have coding 

knowledge as well. If available, an IT person may be a good choice for this role. Once a Spreadsheet Data 

Manager has been appointed, he or she will need to contact the AIMS Center directly for a copy of the 

Spreadsheet Data Manager instructions. 
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Section I – Using the Spreadsheet 
 

Getting started in Excel® 

First, open the spreadsheet. You will see this message: 

 

It is CRITICAL that you click “Enable Content” and “Enable Editing,” otherwise the spreadsheet will not 

work properly. If you did not do this upon opening the spreadsheet template, you should re-download it 

and open it again to ensure macros are enabled. 

If you did not see this message, you should check your settings to make sure you have macros in this 

document enabled by doing the following: 

1. Go to File > Options > Trust Center 

2. Click the button for Trust Center Settings 

3. Go to Macro Settings, and make sure the second option for “Disable all macros with 

notification” is selected. 

4. Click “OK” to save these settings, and then re-download and re-open the document. The 

warning should now display, and you should click “Enable Content.” 

Another change you will need to make in the very beginning is the following: 

1. Go to File > Options > Advanced 

2. Scroll all the way to the bottom, and you will see a section for “Lotus compatibility” 

3. Select the check box for “Transition navigation keys,” then click “OK” to save the settings 

 

Below are some basics for getting around in Excel®:   

Excel® has columns (vertical, designated by letters), rows (horizontal, designated by numbers) and cells 

(individual boxes at the intersection of a column and row). 

To move from one cell to another, you can always use the mouse to click on different cells. In addition to 

the mouse, there are many different keyboard shortcuts. Below are some common keyboard shortcuts 

to move from one cell to another:  
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Action Keyboard Shortcut 

Move to the cell below Press the “Enter” key 

Move up, down, right, or left Use the arrow keys 

Move right Press the “Tab” key 

Move several rows up or down Press the “Page Up” or “Page Down” key 

Automatically move to the far left (Column A) Use the “Home” key 

Search the document to find a specific word/phrase 
(e.g., MRN) 

Press “Ctrl+F” and type the word or phrase you would like to 
find in the pop-up box 

 

You can also undo or redo an action. If you want to undo something, click the curved ("backward") 

arrow in the top-left corner of the screen, or press “Ctrl+Z”; each time you click it, it will undo the 

previous step. It will go all the way back to when you last saved the document.  You can also reverse this 

"undo" command by clicking the other ("forward") arrow, or press “Ctrl+Y.” This redo command can also 

be used to repeat the last action you performed. 

If you need to create a new line of text within the same cell (e.g., if you want two different lines of text 

in the Care Manager Contact Notes), press “Alt+Enter” when you want to jump to the next line. 

Spreadsheet Orientation and Data Entry 
Each care manager will use an individual copy of the spreadsheet. If patients need to be transferred 
from one care manager’s spreadsheet to another, the information can be copied and pasted per the 
instructions under Transferring a patient to another care manager’s spreadsheet. 

The spreadsheet contains three separate worksheets called “Disclaimer,” “Patient Tracking,” and 
“Caseload Overview.”  You can switch between the worksheets using the tabs in the bottom-left corner.  

 The Disclaimer worksheet contains the text on page 4 of these instructions, under Disclaimer 
and Information Regarding HIPAA Compliance. Upon first opening the document, you will have 
to agree to the terms before proceeding. Once you agree to the terms, you will not receive a 
notification for this page again.  

 The Patient Tracking worksheet is where you will enter data related to patient contacts.  

 The Caseload Overview worksheet provides a summary view of that data which can be used to 
identify and sort patients for psychiatric case review.  

 
On the Patient Tracking worksheet, some cells are shaded, and some are white. Enter information only 
into cells that are white. All other cells on the worksheet are locked because they either contain 
formulas critical to the spreadsheet working or are not intended to contain information. For this reason, 
you will need to ask your designated Spreadsheet Data Manager to make any significant changes to the 
spreadsheet, like adding or deleting rows. 
 
The first two rows (headers) give information about what is contained in the cells below for each 

patient. For example, all information regarding PHQ-9 and GAD-7 scores is under the Row 1 heading 

“Measurements,” and all contact dates are under the Row 1 heading “Contacts.” 

Each patient has a set of sixteen rows. The first (purple) row for each patient will represent Initial 

Assessment information for the current episode of care and has “Current Episode Initial Assessment” as 

the contact number in Column G. The fifteen rows underneath the first row represent separate follow-

up contacts with the patient.  

The required fields for every new patient on the spreadsheet are MRN, Name, Treatment Status, 

Episode Number, and Actual Contact Date. To enter these items, first enter the MRN, Name, and 
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Treatment Status into the white cells in the first row of the new patient record. Then, go down to the 

next (second) row and fill in the Episode Number (“1” if this the first time the patient has enrolled in 

care) and Actual Contact Date. The other white cells in this row should be filled out as well, but the 

aforementioned information is required for the spreadsheet to function properly. 

Fixed top rows – Both worksheets are set up so that the top rows with the descriptors are always visible, 

so as you move down to the lower rows, the headings will stay put. Additionally, the “MRN” and “Name” 

columns are fixed so that you can always see them if you need to scroll laterally. 

Saving the document and using auto-backup – You should make a habit of saving backups of your 

spreadsheet with a date attached to the file name rather than continuously saving it as the same 

document. If something odd happens in your working version, you will want a backup to revert to.  One 

option for doing this is using the auto-backup feature in Excel®, which can be accessed by selecting File > 

Save As > Tools > General Options, then checking the box for “Always create backup.” The only 

drawback with this feature is that it will consistently overwrite the last backup with a new backup each 

time you save the spreadsheet, unless you rename the backup file manually. It is encouraged that you 

do rename the backup file with a date in the name so that you have more than one backup to revert to 

if needed. If you prefer not to use this method, you should save your active spreadsheet with a new date 

in the file name each time you save it. 

Printing the Patient Tracking worksheet – First, you must set the print area so that it only prints the 

patients for whom you want to see records. If you simply click “Print,” it will print many, MANY pages.  

To set the print area: 

1. First, make sure all filters in the top row are set how you would like them to be (for example, 
only showing most recent visits or only showing the active caseload).  

2. Find the last row of data that you would like to print. Click on the cell in Column R (or whatever 
your last column is if your spreadsheet has been altered) that corresponds with the last row you 
want to print.  

3. While the last cell you want to print is still selected, drag the right-hand scrollbar upward until 
you reach the top of the page.  Press and hold “Shift,” then click the top-left cell.  All cells that 
you want to print should now be highlighted. 

4. Go to the Page Layout tab, click Print Area, and click on “Set print area.”   

To print after setting the print area:  

Go to File, then Print, then change the print settings to fit all columns on one page in landscape view 

with narrow margins. If you are working in Excel® 2010, use the following steps: 

1. Under Settings, use the fourth drop-down to select Landscape Orientation 

2. Use the sixth drop-down to select Narrow Margins 

3. Use the last drop-down to select Fit All Columns on One Page 

If you are working in another version of Excel®, use the following steps once you are in the Print menu: 

1. Click on Page Setup 

2. On the Page tab, select Landscape under the Orientation heading, and under Scaling select the 
option for “Fit to…” Fill in “1” in the first box for page width, and leave the second box blank. 
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3. On the Margins tab, change to 0.75 on top and bottom and 0.25 on left and right. 

Before you print the document, be sure to look at each page by clicking through them in the Print 

Preview screen. Once you are satisfied, print the document.   

Printing the Caseload Overview worksheet – Go to File, then Print, then change the print settings to the 

following if you are working in Excel® 2010: 

1. Under Settings, use the fourth drop-down to select Landscape Orientation 

2. Use the sixth drop-down to select Narrow Margins 

3. Use the last drop-down to select Fit All Columns on One Page 

If you are working in another version of Excel®, use the following steps once you are in the Print menu: 

1. Click on Page Setup 

2. On the Page tab, select Landscape under the Orientation heading, and under Scaling select the 
option for “Fit to…” Fill in “1” in the first box for page width, and leave the second box blank. 

3. On the Margins tab, change to 0.75 on top and bottom and 0.25 on left and right. 

Before you print the document, be sure to look at each page by clicking through them in the Print 

Preview screen. Once you are satisfied, print the document.   

Transferring a patient to another care manager’s spreadsheet – When a patient’s care is transitioned 

to another care manager, the information will need to be transferred to the care manager’s individual 

copy of the spreadsheet. Keep in mind that locked cells cannot be copied and pasted. If formatting is not 

the same between spreadsheets, you can use the option to paste values instead of pasting everything 

(see page 17 for a screenshot of this). One systematic way to transfer information is as follows: 

1. If you have two computer monitors, pull up an instance of Excel in each one so that you can 

view the spreadsheets side-by-side. 

2. Copy (“Ctrl + C”) white cells for MRN, Name, and Treatment Status (Columns A, B, and C) and 

paste (“Ctrl + V”) into the new spreadsheet 

3. If your spreadsheet to which you are transferring data does not contain formulas in the white 

cells of Episode Number (Column F): Copy white cells with an Episode Number (Column F) and 

paste into the new spreadsheet 

If your spreadsheet to which you are transferring data does contain formulas in the white cells of 

Episode Number (Column F): You do not need to do anything with this column unless the patient 

had more than one episode of care (has an episode number >1 displayed in the purple cell) 

4. Choose the appropriate follow-up schedule in the first cell of Column H of the new spreadsheet 

5. Copy white cells in the columns for Actual Contact Dates, Type of Contact, and PHQ-9 Score 

(Columns J, K, and L) and paste into the new spreadsheet 

6. Copy white cells with GAD-7 scores (Column N) and paste in the new spreadsheet 

7. Copy Care Manager Contact Notes (Column P) and paste in the new spreadsheet 

8. Determine if a Flag in Column Q of the new spreadsheet 

9. Copy white cells with Psychiatric Case Review dates (Column R) and paste in the new 

spreadsheet 
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Section II – Patient Tracking Worksheet: Overview of Functionality 
Included below is a description of the function of each of the columns and rows in the Patient Tracking 

worksheet (the second sheet in the Patient Tracking Spreadsheet Template). 

Column A: MRN 
When you type the patient’s MRN into the first row it will automatically populate to the rows 

underneath. Enter the MRN only in the top row of each patient section. See Spreadsheet Orientation 

for information about how patient sections are organized. 

MRN is required to properly display information on the Caseload Overview worksheet (see Section III – 

Caseload Overview Worksheet: Overview of Functionality). If you do not enter an MRN, but a name is 

entered in Column B, the column will turn red to notify you that MRN is required. 

Please Note: Never enter a number less than 100 in this column, as it may affect other elements 

of the spreadsheet. 

Column B: Name 
When you type the patient’s name into the first row it will automatically populate to the rows 

underneath. Enter the patient name only in the top row of each patient section. You may choose 

whichever name format you would like for this column (e.g., First Last or Last, First). See Spreadsheet 

Orientation for information about how patient sections are organized. 

Column C: Treatment Status 
In the first (Initial Assessment) row for each patient, there is a white cell in Column C. If you select this 

cell, you will see a drop-down menu arrow appear that allows you to select “Active,” “Relapse 

Prevention,” or “Inactive.”  

This column allows you to easily hide your inactive caseload without losing any information, which is 

particularly useful if a patient is ever re-enrolled in care. If a patient is re-enrolled, the information from 

their previous episode has been retained, and you can simply change their status to “Active” again. See 

Column F: Episode Number for more information on tracking on multiple episodes. 

This column has a data filter button. The data filter button is a small grey arrow in Row 2. If you left-click 

on the button a list will appear that includes categories such as “Select All” and “Active.” If you click on 

one of these categories, the data will be filtered so that only visits with the selected (check mark) 

categories listed in Column C are displayed 

To move a patient to inactive status and hide them from the active caseload: 
 

1. Select the white cell in Column C, and select “Inactive” from the drop-down menu. 

2. Select the “Select all” option from the check mark categories using the Treatment Status filter in 
Row 2, then deselect “Inactive” and click “OK.” This will hide all inactive patients.  

3. You can return to viewing all active and inactive patients by clicking on the check mark category 
for “Select All.” 

Treatment Status is required to properly sort the Caseload Overview worksheet (see Section III – 

Caseload Overview Worksheet: Overview of Functionality). If you do not enter a status, but an MRN is 

entered in Column A, the column will turn red to notify you that a status is required. 
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Column D: Display 
This is a hidden column that can optionally be unhidden and utilized to view the spreadsheet in one of 

two condensed forms. However, the spreadsheet must always be changed back to its expanded form in 

order to be able to enter new data (since the condensed forms hide blank contact rows). 

If unhidden, the column has a data filter button. The data filter button is a small grey arrow in Row 2. If 

you left-click on the button a list will appear that includes categories such as “Select All” and “Show 

Initial Assessment row.” If you click on one of these categories, the data will be filtered so that only visits 

with the selected (check mark) categories listed in Column D are displayed. When you want to return to 

the main view, click on the check mark category for “Select All.” 

To view the spreadsheet in a condensed form that hides contacts from previous episodes of care: 
1. Click the filter in Row 2 (Display), and deselect the check mark category that says “DESELECT to 

hide past tx episodes.” 

2. Keep the check mark categories for “Show Initial Assessment row,” “Show only most recent visit 
and ticklers,” and “Blanks” selected. 

3. When you want to return to the main (expanded) view displaying all visits, click on the check 
mark category for “Select All.”   

To view the spreadsheet in a condensed form that displays only the Initial Assessment row, the most 
recent contact, and contacts with ticklers in Column E: 

1. Click the filter in Row 2 (Display), and deselect the check mark categories that say “DESELECT to 
hide past tx episodes” and “Blanks.” 

2. Keep the check mark categories for “Show Initial Assessment row” and “Show only most recent 
visit and ticklers” selected. 

3. When you want to return to the main (expanded) view displaying all visits, click on the check 
mark category for “Select All.”   

Column E: Tickler 
This is a formula-driven column. It will notify you if a contact is past due for a patient or if there is a 

contact due in the next 5 days. The green notice for “Contact due in [# days/today]” will appear 

beginning 5 days prior to the date that the next follow-up is due (Column H), and it will count down until 

the day the contact is due. If the follow-up due date has passed AND there is no actual contact date 

recorded (Column J), then Column E will display the message “Past Due” in red. 

This column has a data filter button. The data filter button is a small grey arrow in Row 2. If you left-click 

on the button a list will appear that includes categories such as “Select All,” “Past Due,” “Contact due in 

[#] days,” and “Blanks.” If you click on one of these categories, the data will be filtered so that only visits 

with the selected (check mark) categories listed in Column E are displayed. When you want to return to 

the main view, click on the check mark category for “Select All.” 

If needed, you can customize the messages (e.g. “Contact due in [#] days” and “Past Due”) that appear 

as well as the timeframe for each message. Please contact your designated Spreadsheet Data Manager 

to do this for you.  
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Column F: Episode Number 
A treatment episode or episode of care is defined as the time period spanning a patient’s enrollment in 

care and subsequent discharge. This column is used to track a patient’s active episode of care while 

retaining information from their previous episode(s). The number in the first row (purple box) for a 

given patient reflects their current episode of care, and it will automatically populate with the most 

recent episode based on the values entered in the rest of the column.  

The number in this column is not the same as the follow-up contact number. Typically, the number in 

this column will always be “1” unless the patient has been discharged and re-entered care. Going down 

the column, the episode number will correspond to the respective follow-up contact.  

Example: If follow-up contact number 4 took place during the patient’s first episode of care, and contact 

number 5 took place during the patient’s second episode, then the number in Column F for contacts 1-4 

should be 1, and the number for contact 5 and beyond should be 2. The number in the first row (purple 

box) automatically populates with the most recent episode number, so it will display 2 in this case. 

Depending on the version of the spreadsheet that you are working on, the column works slightly 

differently: 

A) In versions of the spreadsheet that do not have a version number noted next to the agreement 

date on the Disclaimer tab: You must enter an episode number for every contact. If you do not 

enter an episode number for a given contact, but an actual contact date is entered in Column J, 

the cell will turn red to notify you that an episode number is needed. This number is critical to 

calculations in the Caseload Overview worksheet (see Section III – Caseload Overview 

Worksheet: Overview of Functionality). 

B) In versions of the spreadsheet that have a version number noted next to the agreement date on 

the Disclaimer tab:  The episode number will automatically populate as “1” whenever an actual 

contact date is entered in Column J. However, if a patient is discharged and re-enrolls in care at 

a later time, you will need to manually change the episode number to “2” in the appropriate 

contact row to start the new episode. After that, all contacts will populate with “2.” 

Creating a new episode of care: If a patient has started a new episode of care (and has a previous 

episode recorded in the spreadsheet) creating a new episode is simple: 

1. In the filter for Column C, select the category for “Inactive” to bring up the patient’s record (see 

Column C: Treatment Status for more information on this filter). 

2. Change the Treatment Status in Column C to “Active.” 

3. Type in the next consecutive episode number in Column F (Episode Number). The 

corresponding cell in Column G (Follow-up Contact Number) should now say “Initial 

Assessment.” 

4. Enter the Initial Assessment date in the corresponding cell of Column J (Actual Contact Dates), 

and you will see this date populate in the purple cell at the top of the column. 

5. Enter Initial Assessment scores as appropriate in the same row, and you will see these scores 

populate in the purple cells of the corresponding columns. 
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6. The patient is now enrolled in a new episode of care. 

Column G: Follow-up Contact Number 
Each patient has a set of sixteen rows. The first (purple) row for each patient will represent Initial 

Assessment information and has “Current Episode Initial Assessment” as the contact number in Column 

G. The fifteen rows underneath the first row represent separate follow-up contacts with the patient. 

Column G will automatically track the number of contacts for a patient, beginning with “Initial 

Assessment” and then counting numerically from 1 in the following rows. When the episode number 

changes in Column F, the corresponding cell in Column G will restart with “Initial Assessment.” 

If needed, you can insert additional contact rows for a given patient, but because the spreadsheet is 

locked to protect its embedded formulas, you will need to contact your designated Spreadsheet Data 

Manager to add them. 

Column H: Date Follow-up Due 
This column is formula-driven. The dates that appear in this column also drive the messages that appear 

in Column E (Tickler). In order for follow-up due dates to appear, an Initial Assessment date must be 

entered in Column J. 

The only cell you can edit in this column is the white cell in the first row for each patient. If you select 

this cell, a drop-down menu arrow appears that allows you to select “1-week follow-up schedule,” “2-

week follow-up schedule,” or “1-month follow-up schedule.” These selections determine the dates that 

populate the remainder of the column. If you do not select anything, the dates will automatically follow 

a 2-week follow-up schedule. 

Though, the follow-up due dates are calculated according to the schedule that you choose in the first 

row, they will re-calculate according to the actual contact dates you enter in the next column (Column 

J). For example, if you choose a 2-week follow-up schedule, the dates in Column H calculate in 2-week 

increments from the last actual contact date in Column J. See an illustration of this concept below. 

  

 

 
 
 
 
 
 
 

 

If, in the middle of a patient’s treatment episode, you want to change the frequency of follow-up 
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from the last actual contact date, the next follow-up date will automatically adjust according to your 

new schedule. 

Column J: Actual Contact Dates 
This column is used to enter the date that you had contact with the patient. This includes the Initial 

Assessment date, which would be the date of your first contact with the patient or the date when you 

first begin using the Patient Tracking Spreadsheet Template with them. Enter the Initial Assessment date 

in the first white cell of Column J. The Initial Assessment date for the current episode of care will 

automatically populate in the first (purple) cell of this column, meaning you can always refer to this cell 

for the patient’s start date. Dates in this column also affect the follow-up due dates that appear in 

Column H. See Column H: Date Follow-up Due for more information on how dates are calculated. 

In order to prevent date typos, which will cause a date to not be counted in the Caseload Overview 

worksheet (see Column G: Follow-up Contact Number), this column has a warning that appears if an 

incorrect date is entered or if text other than a date is entered. The warning says, “If you entered a date, 

there is an error in the text. If you entered plain text (e.g., ‘Missed’ or ‘Canceled’) you can ignore this 

warning and proceed by clicking ‘Yes.’” In other words, you can ignore the warning if you are not 

entering a date, but if you are entering a date, you need to correct it. 

Column K: Type of Contact 
Enter the type of contact for each follow-up contact here. A drop-down menu is supplied to quickly 

choose “In person at clinic,” “Phone,” “Group,” “Home,” or you may type in your own text. 

Column L: PHQ-9 Score 
The PHQ-9 score for a given contact is entered in Column L of the corresponding row for that contact. 

The Initial Assessment score will automatically populate in the first (purple) cell of the column, giving 

you a quick visual for the patient’s initial score for the current episode of care. 

If there is no score to record for a given contact, the corresponding cell must have a period “.”, as it 

affects other formulas in the spreadsheet. If a cell is left blank, it will turn red until something (a value or 

a period) is entered so that the formulas in the spreadsheet can continue to work properly. At least one 

PHQ-9 score must be entered for a given patient in order for any other scores to display properly on the 

Caseload Overview worksheet. 

When a patient has reported a PHQ-9 score of <5, the score will turn green when entered. This indicates 

that the score is at target and can aid in identifying patients ready for relapse prevention planning. 

Disclaimer regarding target scores: This spreadsheet reflects PHQ-9 improvement scoring that is 

consistent with HEDIS depression metrics. NCQA has not established a metric for anxiety symptoms 

utilizing the GAD-7. GAD-7 scoring of less than 10 is considered mild anxiety.  

If your organization uses different targets for PHQ-9 or GAD-7 scores, please contact your designated 

Spreadsheet Data Manager to revise these for you. 

Note regarding a deferred initial PHQ-9 score: If you do not obtain a patient’s PHQ-9 score at the Initial 

Assessment, you should leave the period “.” in the cell, and then add the score to the appropriate 

follow-up contact once it is acquired. The purple cell at the top of the column will display “No score” 

http://www.ncqa.org/HEDISQualityMeasurement/HEDISLearningCollaborative/HEDISDepressionMeasures.aspx
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until a score is obtained for the current episode of care. Once a score is obtained at a follow-up contact, 

this will count as the Initial Assessment PHQ-9 score and populate to the purple cell, regardless of 

whether or not the score is entered in the contact row labeled “Initial Assessment” in Column G. 

Column M: Percent Change in PHQ-9 Score 
This column has a formula that shows the change in the PHQ-9 score from the Initial Assessment. A 

value with a negative sign (e.g., -47%) means that the PHQ-9 score has decreased by 47%. A positive 

value means that the PHQ-9 score has increased by the amount shown. 

When a patient’s score has decreased by at least 50% (-50%) the percentage in Column M will turn 

green. This indicates that the score is at target and can aid in identifying patients ready for relapse 

prevention planning. 

Disclaimer regarding target scores: This spreadsheet reflects PHQ-9 improvement scoring that is 

consistent with HEDIS depression metrics. NCQA has not established a metric for anxiety symptoms 

utilizing the GAD-7. GAD-7 scoring of less than 10 is considered mild anxiety.  

If your organization uses different targets for PHQ-9 or GAD-7 scores, please contact your designated 

Spreadsheet Data Manager to revise these for you. 

Column N: GAD-7 Score 
The GAD-7 score for a given contact is entered in Column N of the corresponding row for that contact. 

The Initial Assessment score will automatically populate in the first (purple) cell of the column, giving 

you a quick visual for the patient’s initial score for the current episode of care. 

If there is no score to record for a given contact, the corresponding cell must have a period “.”, as it 

affects other formulas in the spreadsheet. If a cell is left blank, it will turn red until something (a value or 

a period) is entered so that the formulas in the spreadsheet can continue to work properly.  

When a patient has reported a GAD-7 score of <10, the score will turn green when entered. This 

indicates that the score is at target and can aid in identifying patients ready for relapse prevention 

planning. 

Disclaimer regarding target scores: This spreadsheet reflects PHQ-9 improvement scoring that is 

consistent with HEDIS depression metrics. NCQA has not established a metric for anxiety symptoms 

utilizing the GAD-7. GAD-7 scoring of less than 10 is considered mild anxiety.  

If your organization uses different targets for PHQ-9 or GAD-7 scores, please contact your designated 

Spreadsheet Data Manager to revise these for you. 

Note regarding a deferred initial GAD-7 score: If you do not obtain a patient’s GAD-7 score at the Initial 

Assessment, you should leave the period “.” in the cell, and then add the score to the appropriate 

follow-up contact once it is acquired. The purple cell at the top of the column will display “No score” 

until a score is obtained for the current episode of care. Once a score is obtained at a follow-up contact, 

this will count as the Initial Assessment GAD-7 score and populate to the purple cell, regardless of 

whether or not the score is entered in the contact row labeled “Initial Assessment” in Column G. 

  

http://www.ncqa.org/HEDISQualityMeasurement/HEDISLearningCollaborative/HEDISDepressionMeasures.aspx
http://www.ncqa.org/HEDISQualityMeasurement/HEDISLearningCollaborative/HEDISDepressionMeasures.aspx
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Column O: Percent Change in GAD-7 Score 
This column has a formula that shows the change in the GAD-7 score from the Initial Assessment. A 

value with a negative sign (e.g. -47%) means that the GAD-7 score has decreased by 47%. A positive 

value means that the GAD-7 score has increased by the amount shown. 

When a patient’s score has decreased by at least 50% (-50%) the percentage in Column O will turn 

green. This indicates that the score is at target and can aid in identifying patients ready for relapse 

prevention planning. 

Disclaimer regarding target scores: This spreadsheet reflects PHQ-9 improvement scoring that is 

consistent with HEDIS depression metrics. NCQA has not established a metric for anxiety symptoms 

utilizing the GAD-7. GAD-7 scoring of less than 10 is considered mild anxiety.  

If your organization uses different targets for PHQ-9 or GAD-7 scores, please contact your designated 

Spreadsheet Data Manager to revise these for you. 

Column P-Q: Care Manager Contact Notes and Flag for Psychiatric Case Review 
Column P is an all-inclusive notes section. It should include notes about referral to specialty services, 

appointment reminder calls, and anything else from a contact that was not covered in the other 

columns. If you use this column to indicate that an appointment reminder call was made (so that you 

are not counting it as an actual follow-up contact), it is useful to change the color of the text to make it 

stand out and also use “Alt+Enter” to separate lines of text if there are other notes entered in the same 

cell (see Getting started in Excel®). To change the color of the text, double-click on the cell, then use the 

cursor to highlight the text you would like to change. In the Home tab of the toolbar, use the dropdown 

arrow on the          icon to select a color. 

The first cell in Column Q for each patient can be used to flag a patient for discussion with the 

psychiatric consultant (turns yellow when selected), flag a patient as a safety risk (turns light-red when 

selected), or flag both for discussion and as a safety risk (turns orange when selected). These flags 

provide a visual indicator for priority patients in the Caseload Overview worksheet. When the flag is no 

longer needed, it can be removed by clicking on the cell and pressing either “Delete” or “Backspace.” 

There is only one cell in which a flag can be entered for each patient, and the rest of the cells in Column 

Q are locked. 

Column R: Date of Psychiatric Case Review 
When a patient’s care is discussed during a psychiatric case review, enter the date of the review in the 

first blank cell of Column R. The first row of the patient record will automatically display the most recent 

date of review from the patient’s current episode of care in the grey cell. The dates do not need to 

correspond to a particular follow-up contact row. 

  

http://www.ncqa.org/HEDISQualityMeasurement/HEDISLearningCollaborative/HEDISDepressionMeasures.aspx


16 

Section III – Caseload Overview Worksheet: Overview of Functionality 
Included here is a description of the function of each of the columns and rows in the “Caseload 

Overview” worksheet (the third sheet in the Patient Tracking Spreadsheet Template). 

Red Text at the Top of the Caseload Overview Worksheet 
The red text at the top of the Caseload Overview worksheet is extremely important. If an error occurs 

on this page, it is likely that one of the first three items was not followed prior to refreshing the page, 

and you may have to contact your designated Spreadsheet Data Manager to fix it. An explanation of 

each item in red is as follows: 

1. Press “Ctrl+J” to refresh the page EVERY time the worksheet is used, otherwise the information

will be outdated. Each time you press “Ctrl+J,” some default filters are applied, among other

things. These filters remove blank and inactive patients from the list and sort Column G (Date

Next Follow-up Due) from oldest to newest. Make sure all other versions/copies of the Patient

Tracking Spreadsheet Template (including those belonging to other care managers) are CLOSED

before pressing “Ctrl+J.” Using this command will affect all open spreadsheets, so it will damage

a spreadsheet that does not meet the two-patient requirement described below.

2. Do NOT use the worksheet if there are fewer than two patients on the Patient Tracking

worksheet with a Treatment Status of “Active” (or “Relapse Prevention”) in Column C.

Attempting to use it with less than two active patients will cause the worksheet to break.

3. Do NOT make changes to the Caseload Overview worksheet. The only changes you should be

making are sorting and filtering using the filters in Row 4. Hiding or un-hiding columns is

allowable, but this will be reset as soon as the page is refreshed again. If for any reason you

need to make changes other than sorting/filtering or hiding/un-hiding columns, you will need to

copy the worksheet into a new document, instructions for which can be found under

De-Identify the Caseload Overview for Sending. Note that you will no longer be able to refresh

the worksheet or link to patient records from Column A when the new version is created.

4. Due to the way in which the formulas work and the assumption that every patient in the Patient

Tracking Spreadsheet Template will have a PHQ-9 score recorded at some point, there is a

requirement that at least one PHQ-9 score must be entered for a given record in order for the

record’s GAD-7 scores to display correctly in the Caseload Overview. If there is a GAD-7 score

entered for a given record, but there is no PHQ-9 score, the GAD-7 score in the Caseload

Overview will still display “No Score” until a PHQ-9 score is entered.

De-Identify the Caseload Overview for Sending 
Sometimes it may be necessary to send a de-identified Caseload Overview to someone such as a 

psychiatric consultant. To do so: 

1. Download the De-Identified Caseload Overview Template here.

2. Adjust the template however necessary to match your current Caseload Overview (if it has been

customized from the original template). Save this template if you will need it again in the future.

3. On the original Caseload Overview, highlight the columns for “Name” and “Date of Initial

Assessment.” Right-click and select “Unhide” to display the MRN column. Then, highlight the

Name column, right-click, and select “Hide.”

https://aims.uw.edu/resource-library/patient-tracking-spreadsheet
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4. Click on cell B5 (which should be the Treatment Status for the first record) and highlight all of 

the cells through the last row and last column with data in the table. Copy the highlighted area. 

5. Go to the template you downloaded. Right-click on cell B5 and paste VALUES ONLY by selecting 

the “123” icon under “Paste Options” (see below). 

6. Double-check that you pasted MRNs rather than names, then feel free to save the spreadsheet 

and send it. You may also edit this spreadsheet in any way you would like. 

Column A: View Record 
This column provides a hyperlink to each patient’s record on the Patient Tracking worksheet. The record 

will appear at the top of the screen when you select the hyperlink as long as you have changed the 

settings for “Lotus compatibility” as described in Getting started in Excel®. 

Column B: Treatment Status 
This column has a default filter to display only Active and Relapse Prevention patients. If you would like 

to view the Inactive caseload, you may select that category from the filter drop-down menu. (Note: If 

you do not have any Inactive patients on the Patient Tracking worksheet, this category will not display in 

the filter for Column B.) If you would like to reset default settings, press “Ctrl+J.”  

Column C: Name 
This column displays the patient’s name. If you prefer to have the MRN display instead of the patient’s 

name, you have a couple of options: 

1. For a short-term fix that will be reset the next time you press “Ctrl+J,” unhide Column D by 

highlighting Columns C and E, then right-clicking and selecting “Unhide”. Then, you can highlight 

Column C, right-click, and select “Hide.”  

2. For a long-term fix in which MRN always displays instead of the patient’s name, you will need to 

contact your designated Spreadsheet Data Manager to make the change. 

Column E: Date of Initial Assessment 
This column displays the Initial Assessment date for the current episode of care. 

Column F: Date of Most Recent Contact 
This column displays the last Actual Contact Date (in Column J of the Patient Tracking worksheet) 

entered for the patient’s current episode. It excludes contacts for which anything except a date is 

entered (e.g., “Canceled” or “Missed”). If the most recent contact was the Initial Assessment, that date 

will display in this column. If the most recent contact is more than 1 month (30 days) old, a yellow 

exclamation mark will appear next to the date as a visual indicator that the patient has not been 

contacted for over 1 month. 
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Column G: Date Next Follow-up Due 
This column displays the next follow-up due date from the Patient Tracking worksheet. If the contact is 

past due, a red flag will appear next to the date as a visual indicator that it requires follow-up. The 

Caseload Overview worksheet is set up to automatically sort this column by oldest to newest each time 

the page is refreshed. 

Column H: Number of Follow-up Contacts 
This column counts the number of Actual Contact Dates that have a date entered (regular text is not 

counted) in Column J of the Patient Tracking worksheet for the current episode only. It is very important 

that your dates are formatted correctly (no typos) for this column to work properly.  

Column I: Weeks in Treatment 
This column counts the number of weeks that have passed since the Initial Assessment date of the 

current episode. 

Column J: Initial PHQ-9 Score 
This column displays the patient’s PHQ-9 score from the Initial Assessment of the current episode. If no 

score is available, “No Score” will display in this cell. At least one PHQ-9 score must be entered for a 

given patient in order for any other scores to display properly on the Caseload Overview worksheet. 

Column K: Last Available PHQ-9 Score 
This column displays the last available PHQ-9 score for the patient’s current episode. If no score is 

available, “No Score” will display in this cell. 

When a patient has reported a PHQ-9 score of <5, a green check mark will appear next to the score. This 

indicates that the score is at target and can aid in identifying patients ready for relapse prevention 

planning. 

Disclaimer regarding target scores: This spreadsheet reflects PHQ-9 improvement scoring that is 

consistent with HEDIS depression metrics. NCQA has not established a metric for anxiety symptoms 

utilizing the GAD-7. GAD-7 scoring of less than 10 is considered mild anxiety.  

If your organization uses different targets for PHQ-9 or GAD-7 scores, please contact your designated 

Spreadsheet Data Manager to revise these for you. 

Column L: Percent Change in PHQ-9 Score 
This column calculates the percent change in the PHQ-9 score from the Initial Assessment. A value with 

a negative sign (e.g., -47%) means that the PHQ-9 score has decreased by 47%. A positive value means 

that the PHQ-9 score has increased by the amount shown. 

When a patient’s score has decreased by at least 50% (-50%) a green check mark will appear next to the 

percentage. This indicates that the score is at target and can aid in identifying patients ready for relapse 

prevention planning. 

Disclaimer regarding target scores: This spreadsheet reflects PHQ-9 improvement scoring that is 

consistent with HEDIS depression metrics. NCQA has not established a metric for anxiety symptoms 

utilizing the GAD-7. GAD-7 scoring of less than 10 is considered mild anxiety.  

http://www.ncqa.org/HEDISQualityMeasurement/HEDISLearningCollaborative/HEDISDepressionMeasures.aspx
http://www.ncqa.org/HEDISQualityMeasurement/HEDISLearningCollaborative/HEDISDepressionMeasures.aspx
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If your organization uses different targets for PHQ-9 or GAD-7 scores, please contact your designated 

Spreadsheet Data Manager to revise these for you. 

Column M: Date of Last PHQ-9 Score 
This column displays the date on which the last available PHQ-9 score was obtained. If the date is more 

than 30 days old, a yellow exclamation mark will appear next to the date as a warning that the score is 

not current. 

Column N: Initial GAD-7 Score 
This column displays the patient’s GAD-7 score from the Initial Assessment of the current episode. If no 

score is available, “No Score” will display in this cell. At least one PHQ-9 score must be entered for a 

given patient in order for the GAD-7 score to display properly on the Caseload Overview worksheet. 

Column O: Last Available GAD-7 Score 
This column displays the last available GAD-7 score for the patient’s current episode. If no score is 

available, “No Score” will display in this cell. 

When a patient has reported a GAD-7 score of <10, a green check mark will appear next to the score. 

This indicates that the score is at target and can aid in identifying patients ready for relapse prevention 

planning. 

Disclaimer regarding target scores: This spreadsheet reflects PHQ-9 improvement scoring that is 

consistent with HEDIS depression metrics. NCQA has not established a metric for anxiety symptoms 

utilizing the GAD-7. GAD-7 scoring of less than 10 is considered mild anxiety.  

If your organization uses different targets for PHQ-9 or GAD-7 scores, please contact your designated 

Spreadsheet Data Manager to revise these for you. 

Column P: Percent Change in GAD-7 Score 
This column calculates the percent change in the GAD-7 score from the Initial Assessment. A value with 

a negative sign (e.g., -47%) means that the GAD-7 score has decreased by 47%. A positive value means 

that the GAD-7 score has increased by the amount shown. 

When a patient’s score has decreased by at least 50% (-50%) a green check mark will appear next to the 

percentage. This indicates that the score is at target and can aid in identifying patients ready for relapse 

prevention planning. 

Disclaimer regarding target scores: This spreadsheet reflects PHQ-9 improvement scoring that is 

consistent with HEDIS depression metrics. NCQA has not established a metric for anxiety symptoms 

utilizing the GAD-7. GAD-7 scoring of less than 10 is considered mild anxiety.  

If your organization uses different targets for PHQ-9 or GAD-7 scores, please contact your designated 

Spreadsheet Data Manager to revise these for you. 

Column Q: Date of Last GAD-7 Score 
This column displays the date on which the last available GAD-7 score was obtained. If the date is more 

than 30 days old, a yellow exclamation mark will appear next to the date as a warning that the score is 

not current. 

http://www.ncqa.org/HEDISQualityMeasurement/HEDISLearningCollaborative/HEDISDepressionMeasures.aspx
http://www.ncqa.org/HEDISQualityMeasurement/HEDISLearningCollaborative/HEDISDepressionMeasures.aspx
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Column R: Flag 
This column displays any flags assigned to a patient’s record in the Patient Tracking worksheet. If you 

would like to remove a flag from a patient’s record, simply press “Backspace” or “Delete” on the 

appropriate flag in the Patient Tracking worksheet. You can click the View hyperlink in Column A to 

quickly access the appropriate record. 

Column S: Date of Most Recent Psychiatric Case Review 
This column displays the most recent psychiatric consultant note as displayed in the Current Episode 

Initial Assessment row on the Patient Tracking worksheet. If no note has been entered (or if the most 

recent note was from a past episode of care) the cell will be blank. It may be helpful to sort this column 

such that cells that are blank appear at the top in order to see who has not yet been discussed with the 

psychiatric consultant. 


